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Thank you for purchasing the Waveform Editor (Model: 707751).  This User’s Manual

contains useful information about the installation, the functions, and the operating

procedures of the Arbitrary Waveform Editor (Model: 707751). This manual assumes that

you will be using data created by the Arbitrary Waveform Editor on the 4-CH, 100 ks/S D/

A Module WE7281 or the 10 MHz Function Generator Module WE7121.

To ensure correct use, please read this manual thoroughly before operation.  Keep this

manual in a safe place for quick reference in the event a question arises.

The manuals listed below are contained in the measuring station and module packages.

Please refer to them, also.

Manual Title Manual No. Description

WE7000 User’s Manual IM707001-01E Comes with the measuring station
WE800/WE400

4-CH, 100 ks/S D/A Module IM707281-01E Comes with the 4-CH, 100 ks/S D/A
WE7281 User’s Manual Module WE7281

10 MHz Function Generator Module IM707121-01E Comes with the 10 MHz Function
WE7121 User’s Manual Generator Module

Package
This package contains the following items.

• Waveform Editor (Model: 707751) setup disk: 1 CD-ROM disk

• User’s Manual IM707751-61E (this manual): 1 piece

Notes
• The contents of this manual describe Arbitrary Waveform Editor Ver 1.1.2.  If you are

using another version of the software, the operating procedures or the figures given in

this manual may differ from the actual software.

• The contents of this manual are subject to change without prior notice as a result of

continuing improvements to the instrument’s performance and functions.

• Every effort has been made in the preparation of this manual to ensure the accuracy

of its contents.  However, should you have any questions or find any errors, please

contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing any or all of the contents of this manual without YOKOGAWA’s

permission is strictly prohibited.

Trademarks
• Microsoft, Windows, and Windows NT are either registered trademarks or trademarks

of Microsoft Corporation in the United States and/or other countries.

• Adobe and Acrobat are trademarks of Adobe Systems incorporated.

• Other product names are trademarks or registered trademarks of their respective

holders.

Revisions
1st Edition: October 1999

2nd Edition: August 2000

Disk No. WE12
2nd Edition: August 2000 (YK)
All Rights Reserved, Copyright © 1999 Yokogawa Electric Corporation
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Notes on Using This Product

Agreement
Restriction on Use

Use of this product (this utility software and manual) by more than one computer at the

same time is prohibited.  Use by more than one user is also prohibited.

Transfer and Lending

Transfer or lending of this product to any third party is prohibited.

Guarantee

Should a physical deficiency be found on the original disk or this manual upon opening

the product package, please promptly inform Yokogawa.  Yokogawa will replace the disk

free of charge only if the claim is made within seven days from the date you received the

product.

Exemption from Responsibility

Yokogawa Electric Corporation provides no guarantees other than for physical

deficiencies found on the original disk or this manual upon opening the product package.

Yokogawa Electric Corporation shall not be held responsible by any party for any losses

or damage caused directly or indirectly by the use or any unpredictable defect of the

product.

Symbols used in this manual
Unit

k Denotes 1000. Example: 100 kHz

K Denotes 1024. Example: 720 KB

Displayed characters

Alphanumeric characters enclosed with [ ] usually refer to characters or setting values

that are displayed on the screen.

Note
Provides information that is important for operating the instrument properly.
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PC System Requirements

Hardware
PC

PC on which Windows 95/98 or Windows NT 4.0 runs.

CPU: Pentium 133 MHz or higher

Internal Memory

32 MB or more (48 MB or more recommended)

Hard Disk

Minimum free space of 20 MB.  (However, this depends on the data size of the waveform

being edited.)
This software uses two temporary files for Undo operations.  For example, the temporary file size

of data consisting of 10 blocks, 10 channels, and data length of 100,000 (same for all blocks) is

derived by the following equation.

10 (blocks) × 10 (channels) × 100,000 (points) × 2 (bytes) + Header size (several KB) = Approx.

19.1 MB.

In this case, the minimum hard disk space is approximately 38.2 MB (two temporary files).

Drive

One CD-ROM drive.  This is used to install this software.

Mouse

Mouse supported by Windows95/98 or Windows NT 4.0

Display

Display supported by Windows 95/98 or Windows NT 4.0 with a minimum resolution of

800-by-600 and 256 colors (analog RGB).

OS
Microsoft Windows 95/98 or Windows NT 4.0
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Installing the Software

Before Installation
Have the setup CD-ROM ready.  Exit all programs that are currently running before

starting the installation.

The following procedures are for installing the software on Windows95/98.

Procedure
1. Start Windows 95/98.

2. Insert the CD-ROM into the CD-ROM drive.

The installation program will start automatically.  If the CD-ROM’s auto run function

is disabled, you must start the program manually.  Start setup.exe located at the root

of the CD-ROM.

The following dialog box will be displayed.

3. To continue the installation, click the [Next] button.

The dialog box for the setting the destination folder to install the software will be

displayed.  The default directory is [C:\ProgramFiles\We7000\Waveform Editor\].  To

change the destination folder, click [Browse...] and select the desired folder.
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Installing the Software

4. After setting the destination folder, click the [Next] button.

Program files will be copied to the hard disk and the progress will be displayed with

a graph.

The installation is complete when the following dialog box appears.

5. Click the [Finish] button to terminate the installation program.
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Starting and Exiting the Arbitrary Waveform Editor

Starting the Software
When the Arbitrary Waveform Editor is installed, [Waveform Editor] is registered in the

start menu (see the figure below).  To start the program, click [Waveform Editor]

Exiting the Software
1. Click [Exit] from the [File] menu or click the “X” button in the upper right portion of the

window.

2. The following dialog box appears.  Click the [OK] button.
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1.1 Overview

The Waveform Editor can be used to open preexisting waveform data files, edit the

waveform data, and save the resultant data in a specified file format.  It can also be used

to create new waveform data and save them in a specified file format.

Waveform data in 
YOKOGAWA’s 
proprietary file format*

XXXX.hdr
XXXX.wvf

Waveform data in 
CSV format

XXXX.csv

Edit or create waveform dataPreexisting waveform data

Edit
• Load data
• Specify function
• Specify constant
• Interpolate linearly
• Delete/Copy/Paste
• Dot edit/Waveform dot edit

Channel
• Insert/Delete/Copy
• Swap
• Edit

Block
• Insert/Delete/Copy
• Swap
• Change data length

Open Export

Output waveform data

Waveform data in 
YOKOGAWA’s 
proprietary file format 
(Can be used on the 
WE7281)

XXXX.hdr
XXXX.wvf

Waveform data for the 
WE7121

XXXX.w16

* Waveform data that are saved to files with “.wvf” extensions.  These files are saved using the WE7000 
measurement modules or other YOKOGAWA instruments.  (However, there may be some waveform data 
files that cannot be loaded correctly such as those containing logic waveforms.)  

Edit screen example

The following figure shows a case where the waveform dot edit function is being used to

edit a section of the loaded waveform at the dot level.

Main waveform 
display screen

Edit waveform 
display screen

Select the name of 
the channel to edit

Cursor used to 
specify the 
expanded area 
(edit screen) Select the block to edit

Cursor used to specify 
the edit area

Chapter 1 Explanation of Functions
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1.2 Files that can be Opened

Waveform Data in YOKOGAWA’s Proprietary File Format (Binary Waveform Data File)
As indicated in the figure below, data are stored using a pair of files, including a header

file (hdr file) and a data file (wvf file).  When collecting waveform data to multiple files on

the WE7000 measurement modules, each data file must have a corresponding header

file.  In addition, if a file consists of waveform data divided into multiple blocks, the

sampling interval (waveform output interval) and the number of channels must be the

same among all blocks.

XXXX001.hdr

XXXX001.wvf

XXXX002.hdr

XXXX002.wvf

XXXXnnn.hdr

XXXXnnn.wvf

. . . 

Specify any one set

[Example of a file that is not supported]

XXXX001.hdr

XXXX001.wvf XXXX002.wvf

Header file

Data file

Note
When saving measured data on the WE7000 measurement modules using the “Save Acquisition

Data” function, check the [Header (on every file)] box in order to create a header file for each

waveform data file.
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1.2 Files that can be Opened

Waveform data in CSV format
• Handled as a single block of data from one channel.

• The maximum number of data points that can be loaded is 4 Mpoints.

• It is assumed that only voltage data are registered.

• The channel name, range, unit, and the D/A output rate during waveform output

(sampling rate on this software) are assumed as follows.

Channel name: CH1

Voltage range: See “Calculating the Voltage Range and Determining the

Voltage” on the next page.

Unit: V

Waveform output interval: 1.0 s

• If the data are saved as one line and m columns, the value of m is taken to be the

number of samples.

• If the data are saved as n lines and m columns, the value of n is taken to be the

number of samples.

• When the data are saved to multiple columns, the data in the first column are used.

Note
If measured data from WE7000 measurement modules are saved in the CSV file format, the file

cannot be used directly.  In order to use the waveform data in the file, copy only the section

containing the waveform data to another file and use that file.

Data Creation Example

[Using Excel] [Viewing on the WordPad]
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Calculating the Voltage Range and Determining the Voltage
All loaded data are handled as though they are voltage data.  The voltage range of the

loaded channel is determined by the following method.

1. Determine the maximum (RMax) and minimum (RMin) values of the data.

For wvf files

Based on the information in the header file (see page 1-9), the following equation is

used to determine the values.

RMin = VResolution × VMinData + VOffset

RMax = VResolution × VMaXData + VOffset

For CSV files

RMin = The minimum value of the loaded data

RMax = The maximum value of the loaded data

2. Determine the maximum voltage of the data.

The larger of the absolute values of RMin and RMax is taken to be VMax (Maximum

value of the voltage range).

3. Determine the voltage range

The voltage range is determined by comparing whether or not VMax is within +2.5% of

the voltage range span (±1 V, ±2 V, ±5 V, ±10 V) to be used in the software.

Example: If VMax = 5.2, the voltage range is set to ±5 V.

If VMax = 5.3, the voltage range is set to ±10 V.

4. Convert the loaded data to voltage values.

If the voltage range determined in step 3 is “±1 V,” “±2 V,” “±5 V,” or “±10 V,” each

value (Xi) is converted to voltage (ADi) using the following equation.

ADi = Xi × (Voltage range/32000)

If the voltage range determined in step 3 exceeds “±10 V,” RMin and RMax are

normalized to ±10 V.

The voltage range is set to “±10 V,” and the following equation is used to convert each

value (Xi) to voltage (ADi).

ADi = Xi × (10/32000)

Note
Any data points loaded into the 4-CH, 100 ks/S D/A module WE7281 that exceed the output

voltage range by one percent or more, are output at the maximum voltage.

1.2 Files that can be Opened
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1.3 Waveform Edit Function/Channel Management/
Block Management

Waveform Edit Function
The following types of editing are possible on loaded or newly created waveforms.  You

can select overwrite, sum, or insert (data points after the insertion point are shifted

backwards and those that exceed the waveform display section are discarded) for the

following operations: load data, specify function, specify constant, paste, and dot edit/

waveform dot edit.  The following descriptions are given with the premise that overwrite

is specified.

Load data

Select the block and channel of the waveform data of the selected file and load one

channel of data.  The data after the cursor 1 position are overwritten with the loaded

data.  However, the loaded data are converted using the voltage range of the channel

being edited.  Thus, data exceeding the range are set to the maximum/minimum values

of the voltage range.  In addition, if the length of the loaded data is greater than “(data

length) – ”data position of cursor 1), the section of the data that exceeds the waveform

display section are not loaded.

Cursor 1

Loaded data

When range is exceeded

Specify function

The waveform data in the specified area are replaced with waveform data created using

the following equation (or waveform).

Raised Cosine: Va × (1 – cos(2πt/T)), Half Sine: Va × Sin(πt/T), Sine wave: Va × Sin(2πft

+ Φ), triangular wave, rectangular wave, pulse wave, and ramp wave.

Raised Cosine Half Sine Sine Triangular Rectangular Pulse Ramp

Cursor 1 Cursor 2

Waveform created using a function

Specifi-
ed area

Specify constant

The waveform data in the specified area are replaced with a specified constant value.

Cursor 1 Cursor 2
Constant V

Interpolate linearly

The waveform data in the specified area are replaced with linearly interpolated values

between the first and last values in the specified area.

Cursor 1 Cursor 2

Linear interpolation
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1.3 Waveform Edit Function/Channel Management/Block Management

Delete

The waveform data in the specified area are deleted, and waveform data subsequent to

the deletion area are shifted forward.

Cursor 1 Cursor 2

Filled using the value 
of the last data point

Delete

Copy/Paste

The waveform data in the specified area are copied and pasted to the start position that

is specified.
Cursor 1 Cursor 2

Cursor 1Copy

Paste

Dot edit/Waveform dot edit

In dot edit, each data point (dot) of the waveform data can be entered numerically to

create a waveform.  As shown in the figure below, you can also plot points through which

the waveform is to pass and then interpolate linearly or by using a 3rd order spline to

create the waveform.  The number of dots that you can plot is 2 to 1000 points.  You can

overwrite, sum, or insert (data points after the insertion point are shifted backwards and

those that exceed the waveform display section are discarded) the created waveform to

the specified area of the waveform being edited.

Spline 
interpolation

Linear interpolation

Passing points

In waveform dot edit, each data point (dot) of the waveform data in the specified area

can be changed.  In addition to entering numeric values of the dots to edit the waveform,

you can change some of the dots so that the rest of the dots fall on the spline curve that

is defined by the changed dots.  You can also delete preexisting dots and interpolate

linearly or by using a spline, as in the dot edit.

Spline approximation line

Line indicating the original waveform

Dot that is moved
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Channel Management
Waveform data can be created by dividing the data into blocks and dividing each block

into channels.  The following operations are possible in units of channels using the same

number of blocks.

1

Block

2 3 4 5

Channel

1

2

3

One set of waveform data

Insert above/Insert below

1Channels can be added up to a total of 80.  The new channels can be added before or

after the reference channel (target channel).  The channel number in this section refers

to the number that is necessary when assigning waveform data to channels on the D/A

module.  It is not the same as the channel name (the “label” that is used in the WE7000

scale conversion function).  The length of the waveform data of the inserted channel is

the same as that of the preexisting channel and the value is set to “0 V.”

Delete

You can delete the specified channel and reduce the number of channels.

Copy

You can copy the waveform data of the specified channel to another channel.  Only

waveform data are copied.  The channel name and unit at the copy destination are not

changed.  However, the voltage range is changed to the voltage range of the destination

channel.

Swap

You can swap waveform data between two specified channels.  This changes the

channel number (order) that is used when loading the data to the D/A module.  The

channel name, voltage range, and unit are also swapped.

Edit

You can change the channel name, voltage range, and unit of the waveform data from

the specified channel.

[Conceptual Diagram of Channel Management]

1

Block 1

Block 2

Block 3

Block 4

2 3 4 5

CH1 CH2 W3 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

Channel number (No.)→

The number of channels 
per each block is the same.
The data length of channels 
can be set for each block.

Channel name
The specified channels

W3

W3

W3

1 2 3 4

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

Delete

1.3 Waveform Edit Function/Channel Management/Block Management
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Block Management
The following operations are possible in units of the waveform data block.

Insert above/Insert below

Blocks can be added up to a total of 256.  The new blocks can be added before or after

the reference block (target block).  The data length per channel can be specified for the

added blocks.  The waveform data of the added blocks are set to “0 V.”

Delete

You can delete the specified block and reduce the number of blocks.

Copy

You can copy all the waveform data of the specified block to another block.

Swap

You can swap all the waveform data between two specified blocks.

Change data length

The data length (number of data points) per block for each channel can be changed in

the range “1 to 4,194,304.”

If the specified data length is greater than the current data length, any data that extend

beyond the original data length are set to “0 V.”

[Conceptual Diagram of Block Management]

1

Block 1

Block 2

Block 3

Block 4

2 3 4 5

CH1 CH2 W3 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

Channel number (No.) →

Originally block 4The specified 
block

W3

W3

W3

Delete

Block 1

Block 2

Block 3

CH1 CH2 W3 CH4 CHA

CH1 CH2 CH4 CHA

CH1 CH2 CH4 CHA

W3

W3

1 2 3 4 5

1.3 Waveform Edit Function/Channel Management/Block Management
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1.4 Output Waveform Data

The waveform data that have been edited can be exported to the following two file

formats.

Waveform data in YOKOGAWA’s proprietary file format (binary waveform data file)
Waveform data are exported to a file in binary format that can be used on the 4-CH, 100

ks/S D/A module WE7281.  The file extension is “*.wvf.”  When this format is used to

export the file, a header file (“*.hdr” extension) in ASCII format is also exported.  The

following table contains an example of a header file.

Item Fixed Value Description
$Publicinfo FormatVersion Fixed 1.01
 Model Fixed WE7281
 Endian Fixed Ltl
 DataFormat Fixed Block
 GroupNumber L Number of groups (see note 1)
 TraceTotalNumber M Number of channels of the data to be edited
 DataOffset Fixed 0
$Group1 TraceNumber M' Number of channels in the group (see note 1)
 BlockNumber N Number of blocks of the data to be edited
 TraceName AAAA . . A Channel name in the group
 BlockSize1 XXX.XXXXXXX Data length/CH for the channels in the group
     .   Set for each block.
 BlockSizeN (see note 2)
 VResolution1 XXX.XXXXXXX Range resolution for the channels in the group
     . Set for each block.
 VResolutionN (see note 2)
 VOffset1 Fixed 0.000000e+000 Offset value for the channels in the group

    . Set for each block.
 VOffsetN (see note 2)
 VDataType Fixed IS2
 VUnit AAAA . . A Unit for the group
 VPlusOverData Fixed 32001 Same for all channels.

 VMinusOverData Fixed -32001 Same for all channels.
 VIllegalData Fixed NAN Same for all channels.
 VMaxData Fixed 32000 Same for all channels.
 VMinData Fixed -32000 Same for all channels.
 HResolution 1.000000e-001 Specified sampling interval (same for all channels)
 HOffset 0.000000e+000
 Hunit Fix S
 Date XXXX/XX/XX Date created (see note 3)
 Time XX:XX:XX Time created (see note 3)
$PrivateInfo PtraceName Fixed CHX(X: 1 to) Default value of the header generation DLL
 PlinearMode Fixed OFF Default value of the header generation DLL
 PlinearSlope Fixed 1.000000e+000 Default value of the header generation DLL
 PlinearIntercept Fixed 0.000000e+000 Default value of the header generation DLL

PlinearUnit Fix ? Default value of the header generation DLL
Note 1: $GroupX is created in groups of four channels.

Example: When TraceTotalNumber = 7
$Publicinfo:$GroupNumber is set to 2.
Information regarding CH1 to CH4 are registered in $Group1.  TraceNumber is set to 4.
Information regarding CH5 to CH7 are registered in $Group1.  TraceNumber is set to 3.

Note 2: BlockSize, VResolution, and VOffset of $GroupX are created for each block.  N is the number of blocks.  
However, all blocks will contain the same data.

Note 3: Date and Time of $GroupX are set to the last date and time when you edited the data.
Example: If new data are created and directly exported to a file, the date and time will correspond to when 

the data were created.
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Waveform data for the WE7121 (FG module file)
Waveform data are exported to a file in a format that can be used on the 10 MHz

Function Generator Module WE7121.  The file extension is “*.w16.”

Since the file contains only one channel of waveform data, the waveform data of the

specified block and channel are exported.

The waveform data file is exported according to the following specifications so that it can

be used in the function generator.

Amplitude direction: Data points are assigned values by taking the minimum value of

the edited waveform to be “1” (negative side of Vp-p) and the

maximum value to be 4095 (positive side of Vp-p).

Time axis direction: Exports 16384 points from the beginning of the edited waveform.

Number of data points: If the number of data points is less than 16384, the remaining

section is filled with “2048” (0 V).  If the number of data points

exceeds 16384, all points beyond the 16384th point are

discarded.

1.4 Output Waveform Data
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2.1 Creating New Waveform Data

Procedure
1. Select [New] from the [File] menu.

2. In the dialog box shown below, set the [Num. of channels], [Num. of blocks], [Data

length] (number of data points), [Range] (voltage range), and the [Sampling rate]

(waveform output rate), and click the [OK] button.

3. In the following dialog box, click the [OK] button.

If you click the [Cancel] button, the screen returns to the dialog box in step 2.

The waveform edit window opens.

Voltage axis scale

Edit waveform display screen

Select the name of 
the channel to edit

Select the block 
to edit

Main waveform 
display screen

Waveform output rate
(Can be changed using 
this entry box)

Chapter 2 New/Open Waveform Data
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2.1 Creating New Waveform Data

Explanation
Number of channels

Select a value in the range from 1 to 80.

When creating waveform data for the Function Generator Module WE7121, use the

default value [1].

Number of blocks

Select a value in the range from 1 to 256.

When creating waveform data for the Function Generator Module WE7121, use the

default value [1].

Data length

Select a value in the range from 1 to 4,194,304.

When creating waveform data for the WE7121, set the value to [16384] (the data length

used by the WE7121 when generating arbitrary waveforms).  When creating waveform

data to be generated in the FG mode on the 4-CH, 100 kS/s D/A Module WE7281, set

the value to [65536] (the data length used by the WE7281 when generating arbitrary

waveforms in the FG mode).

Range

Select the voltage range from “±1 V”, “±2 V”, “±5 V”, and “±10 V.”

Select any appropriate range when creating waveform data for the WE7121.  When the

waveform data are exported, data points are assigned values by taking the minimum

value of the edited waveform to be “1” (negative side of Vp-p) and the maximum value to

be 4095 (positive side of Vp-p).

Sampling rate (waveform output rate)

Select the sampling rate to use when converting the waveform data using the D/A

module.  Set the value in the range “0.000001 s to 1,000 s.”  This setting is ignored when

exporting waveform data for the WE7121.

Note
• Channel names are set to “CH1 to CHn” (where n is the number of channels), and the unit is

set to “V” on all channels.

• Multiple waveform edit windows cannot be opened simultaneously.  In addition, you cannot

change the size of the waveform edit window.

• If the allowed range of the waveform output rate of the D/A module, that is to load the arbitrary

waveform data, is narrower than “0.000001 s to 1,000 s,” values outside the allowed range are

changed to the minimum or maximum value at the time of the load.
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2.2 Opening Waveform Data

Procedure
1. Select [Open] from the [File] menu.

2. Select YOKOGAWA’s proprietary [Binary waveform data file (*.wvf)] or [CSV file

(*.csv)] in the [Files of type] list box in the [Open] dialog box shown below.  Then,

select the file from the file list displayed and open the file.

The waveform edit window opens.

Voltage axis 
scale

Edit waveform display screen

Select the name of 
the channel to edit

Select the block 
to edit

Main waveform 
display screen

Waveform output rate
(Can be changed using 
this entry box)
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Note
• For the specifications of the waveform data to be loaded, see section 1.2, “Files that can be

Opened.”  If the specifications of the waveform data being loaded are not appropriate, an error

message is displayed.

• When creating waveform data for the WE7121, see the “Explanation” on the previous page for

restrictions.

• Multiple waveform edit windows cannot be opened simultaneously.  In addition, you cannot

change the size of the waveform edit window.

2.2 Opening Waveform Data
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3.1 Setting the Waveform Display

Procedure
Selecting main screen channels

Select the channels that will be displayed in the main waveform display screen.  If

multiple channels are selected, the waveforms of the selected channels are displayed

superimposed.

1. Click the [Select main screen channels] from the [View] menu.

2. In the dialog box shown below, check the boxes for the channels that are to be

displayed and click the [OK] button.

As shown in the figure below, the waveform of the channel being edited is displayed

in red and all other waveforms are displayed in green.

Main waveform display screen
Select the name of the 
channel to edit Select the block to edit

Chapter 3 Editing Waveform Data/Managing Channels/Managing Blocks
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3.1 Setting the Waveform Display

Main screen auto scale

Select whether to use auto scale (the maximum and minimum values of the data are set

to full scale) or manual scale (the range specified using the [Set main screen scale]

menu) for the display range of the voltage axis of the main waveform display screen.

Click [Main screen auto scale] from the [View] menu.  Auto scale is enabled when a

check mark is displayed to the left of the [Main screen auto scale] string.

Setting the main screen scale

Select the range when using manual scale to display the voltage axis of the main

waveform display screen.

1. Click [Set main screen scale] from the [View] menu.

2. In the dialog box shown below, enter the minimum value [Min] and the maximum

value [Max] and click the [OK] button.

The allowed scale range is “-99.999 to 99.999.”

As shown in the figure below, the voltage axis scale of the main waveform display

screen changes to the specified values.

Voltage axis scale Main waveform display screen
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Edit screen auto scale

Select whether to use auto scale (the maximum and minimum values of the data are set

to full scale) or manual scale (the range specified using the [Set edit screen scale] menu)

for the display range of the voltage axis of the edit waveform display screen.

Click [Edit screen auto scale] from the [View] menu.  Auto scale is enabled when a check

mark is displayed to the left of the [Edit screen auto scale] string.

Setting the edit screen scale

Select the range when using manual scale to display the voltage axis of the edit

waveform display screen.

1. Click [Set edit screen scale] from the [View] menu.

2. In the dialog box shown below, enter the minimum value [Min] and the maximum

value [Max] and click the [OK] button.

The allowed scale range is “-99.999 to 99.999.”

As shown in the figure below, the voltage axis scale of the edit waveform display

screen changes to the specified values.
Voltage axis scale Edit waveform display screen

Note
The total number of dots in the horizontal direction of the waveform display screen is 1024 points.

When displaying waveform data containing more than 1024 points, the waveform is subdivided

into sections and the maximum and minimum values of each section are displayed at the same

horizontal position.

3.1 Setting the Waveform Display
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3.2 Selecting the Waveform Edit Area

Procedure
As shown in the figure below, first, specify the general area that you wish to edit on the

main waveform display screen.  As default, cursor 1 and cursor 2 are at the left end and

right end of the screen, respectively.  By moving the pointer to the cursor position and

dragging, the cursor can be moved.  The area specified by cursor 1 and 2 in the main

waveform display screen is displayed over the entire edit waveform display screen.

The edit waveform screen also has cursors 1 and 2.  The area specified by cursors 1

and 2 in the edit waveform screen is the area that is to be edited.  You can also set the

area by entering values in the boxes located to the right of the waveform display section.

To move cursors 1 and 2 to the ends of the waveform display section, click the [Left

edge] or [Right edge] button.

Main waveform display screen

Edit waveform display screen

Cursor 1
Cursor 2

Set the cursor position/displays 
the current position

Cursor 2Cursor 1 Edit area

Note
• Various editing operations described in the sections to follow can be performed over the edit

area specified by the above procedure.  The data position specified by cursor 2 is irrelevant for

[Load data] and [Paste] operations.

• For the various editing operations described in succeeding sections, the last operation that was

performed can be cancelled by clicking [Undo] from the [Edit] menu.  In this case, the cursors

return to the ends of the waveform display screen.

• If the right mouse button is clicked on the waveform display screen, [Pair cursor movement]

appears.  By selecting this menu item, one of the cursors can be used to move both cursors.

To cancel this behavior, click the right mouse button again, and select the menu item.
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3.3 Edit - Load Data

Procedure
Carry out the following procedures when overwriting, inserting, or summing the loaded

waveform data (wvf or CSV format) to the position specified by cursor 1 (see previous

section) of the edit waveform display screen.

1. Click [Load data] from the [Edit] menu.

2. In the dialog box shown below, Select the file to be loaded.  If the file contains data

of multiple blocks or channels select the block and channel.  Click the [View graph]

button to display the waveform of the selected data.

Select overwrite/insert/sum Displays the path Displays the file name Select the file

When viewing the waveform

Select the block

Select the channel

Waveform display section

3. In the [Mode] list box, select overwrite, insert, or sum, and click the [OK] button.

4. In the confirmation dialog box, click the [OK] button.

The waveform of the overwritten/inserted/summed data is displayed (the example

below is when the waveform is inserted).
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Note
• The types of waveform data files that can be loaded are the same as those that can be loaded

using [Open] from the [File] menu.  For the specifications of the waveform data, see section 1.2,

“Files that can be Opened.”

• The maximum and minimum values of the waveform data being loaded are used as the

maximum and minimum values of the scale for the waveform that is displayed in the [Load data]

dialog box.

• The settings that are displayed when the [Load data] dialog box is opened are those that were

specified the previous time.  However, [Mode] is always set to [Overwrite] as default.

3.3 Edit - Load Data
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3.4 Edit - Specify Function

Procedure
Carry out the following procedures when overwriting, inserting, or summing the specified

waveform (wvf or CSV format) to the area specified by cursors 1 and 2 (see section 3.2)

of the edit waveform display screen.

1. Click [Specify function] from the [Edit] menu.

2. In the dialog box shown below, select the waveform using the waveform (function)

list box.  Use the parameter setting boxes to the right of the waveform (function) list

box to specify relevant parameters.  The available parameters and their ranges are

as follows.

Ampl (amplitude): 0.001 to voltage range, Offset (off set voltage): Within the voltage

range, Phase: 0.00 to 360.00 (0.01 resolution), Cycle (number of cycles): 0.01 to

number of data points in the edit area/2 (0.01 resolution), Duty (for pulse wave only):

0.00 to 100.00 (0.01 resolution)

Click the [View graph] button to display the specified waveform.

Select overwrite, insert, or sum Set parameters

Select the waveform

When viewing 
the waveform

Waveform display section

3. In the [Mode] list box, select Overwrite/Insert/Sum, and then the [OK] button.

4. In the confirmation dialog box, click the [OK] button.

The waveform of the overwritten/inserted/summed data is displayed (the example

below is when the waveform is inserted).
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Note
• The maximum and minimum values of the waveform data being loaded are used as the

maximum and minimum values of the scale for the waveform that is displayed in the [Specify

function] dialog box.

• The settings that are displayed when the [Specify function] dialog box is opened are those that

were specified the previous time.  However, [Mode] is always set to [Overwrite] as default.

3.4 Edit - Specify Function
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3.5 Edit - Specify Constant

Procedure
Carry out the following procedures when overwriting, inserting, or summing constant

voltage data (wvf or CSV format) to the area specified by cursors 1 and 2 (see section

3.2) of the edit waveform display screen.

1. Click [Specify constant] from the [Edit] menu.

2. In the dialog box shown below, set the voltage value.

The selectable range is equal to the voltage range.
Select overwrite, insert, or sum

Set the voltage

3. In the [Mode] list box, select Overwrite/Insert/Sum, and then the [OK] button.

4. In the confirmation dialog box, click the [OK] button.

The waveform of the overwritten/inserted/summed data is displayed (the example

below is when the waveform is inserted).

Note
The settings that are displayed when the [Specify constant] dialog box is opened are those that

were specified the previous time.  However, [Mode] is always set to [Overwrite] as default.
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3.6 Edit - Interpolate Linearly

Procedure
Carry out the following procedures when linearly interpolating values between the first

and last values in the area specified by cursors 1 and 2 (see section 3.2) of the edit

waveform display screen.

1. Click [Interpolate linearly] from the [Edit] menu.

2. In the confirmation dialog box, click the [OK] button.

As shown in the figure below, the specified area is linearly interpolated.
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3.7 Edit - Delete

Procedure
Carry out the following procedures when deleting the waveform in the area specified by

cursors 1 and 2 (see section 3.2) of the edit waveform display screen.

1. Click [Delete] from the [Edit] menu.

2. In the confirmation dialog box, click the [OK] button.

As shown in the figure below, the specified area is deleted.
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3.8 Edit - Copy/Paste

Procedure
Carry out the following procedures when copying the waveform data in the area specified

by cursors 1 and 2 (see section 3.2) of the edit waveform display screen to the position

specified by cursor 1.

1. Click [Copy] from the [Edit] menu

2. Move cursor 1 to the position at which you wish to paste the copied waveform.

3. Select [Paste] from the [Edit] menu, and click [Overwrite], [Insert], or [Sum] that are

displayed to the right.

4. In the confirmation dialog box, click the [OK] button.

As shown in the figure below, the waveform is pasted starting from the cursor 1

position.
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Note
• If the number of data points of the waveform being pasted is greater than the number of points

from the cursor 1 position to the last data point, the excess data are discarded.

• If the [Load data] operation is performed after the copy operation, the copied data are replaced

by the loaded data.  When the waveform is pasted, the loaded data are used.

3.8 Edit - Copy/Paste
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3.9 Edit - Dot Edit

Procedure
Carry out the following procedures when overwriting, inserting, or summing dot-edited

waveform data to the area specified by cursors 1 and 2 (see section 3.2) of the edit

waveform display screen.

1. Click [Dot edit] from the [Edit] menu.

2. In the waveform plot area of the dialog box, move the pointer to the appropriate

position and click the mouse.

Select overwrite/insert/sumPlotted points Pointer

When viewing the waveform

Displays the information at the 
pointer position/enter numeric 
values

Select the interpolation method

When editing the waveform 
data using numeric values

Waveform plot area

Set the pointer position to the 
specified numeric value

The following figure is an example of a waveform that is displayed when [View

graph] is clicked when [Linear] interpolation is specified.
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The following figure is an example of a waveform that is displayed when  [View

graph] is clicked when [Spline] interpolation is specified.

If the [Edit values] box is clicked, a dialog box appears for you to specify the

waveform using numeric values.  Change the data position (X value) or voltage (Y

value) and click the [OK] button.

Check to delete the data point

3. When you are done editing, select [Overwrite], [Insert], or [Sum] in the [Mode] list

box and click the [OK] button.

4. In the confirmation dialog box, click the [OK] button.

The waveform of the overwritten/inserted/summed data is displayed (the example

below is when the waveform is inserted) in the specified area.

3.9 Edit - Dot Edit
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3.10 Edit - Waveform Dot Edit

Procedure
Carry out the following procedures when editing the waveform data (wvf or CSV format)

in the area specified by cursors 1 and 2 (see section 3.2, area of 1000 points or less) of

the edit waveform display screen and overwriting/inserting/summing the result to the

specified area.

1. Click [Waveform dot edit] from the [Edit] menu.

2. In the waveform plot area of the dialog box, move the pointer to the appropriate

position and click the mouse.

Select overwrite/insert/sumPlotted points Pointer

When editing the waveform data using numeric values

Displays the 
information at the 
pointer position

Select the 
interpolation 
method

When viewing the 
waveform

Waveform plot area

As shown in the figure below, if [View graph] is clicked when [Linear] interpolation is

specified, the section of the waveform that has been changed is displayed in red.
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If the [Edit values] box is clicked, a dialog box appears for you to specify the

waveform using numeric values.  Change the data position or voltage and click the

[OK] button.

Check to delete the data point

3. When you are done editing, select [Overwrite], [Insert], or [Sum] in the [Mode] list

box and click the [OK] button.

4. In the confirmation dialog box, click the [OK] button.

The edited waveform is overwritten/inserted/summed in the specified area (the

example below is when the waveform is overwritten).

3.10 Edit - Waveform Dot Edit
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3.11 Channel - Insert Above/Insert Below

Procedure
Carry out the following procedures when adding a new channel.

1. Click [Insert above] or [Insert below] in the [Channel] menu.

To create a channel before the target channel, select [Insert above].  To create a

channel after the target channel, select [Insert below].

2. In the dialog box shown below, select the [Target channel] from the list box.  Select

the name, voltage range, and unit for the new channel and click the [OK] button.

In the example shown below, a new channel is created after [CH1].  The name,

voltage range, and unit for the new channel are [CH4], [1 V], and [V], respectively.

3. In the confirmation dialog box, click the [OK] button.

Note
• Up to 80 channels can be created.

• Each channel name must be unique.

• Specify the channel name using up to 15 characters.  The following characters can not be used:

["], [\], [/], [,], [.], [:], [;], [<], [>], [?], [*], [ | ], and [space].



3

3-19IM 707751-61E

E
d

itin
g

 W
avefo

rm
 D

ata/M
an

ag
in

g
 C

h
an

n
els/M

an
ag

in
g

 B
lo

cks

3.12 Channel - Delete

Procedure
Carry out the following procedures to delete a channel.

1. Click [Delete] from the [Channel] menu.

2. In the dialog box shown below, select the [Channel] from the list box, and click the

[OK] button.

In the example shown below, [CH4] is selected as the channel to be deleted.

3. In the confirmation dialog box, click the [OK] button.

Note
• If the channel being edited is deleted, the channel with the smallest number becomes the new

channel that is edited.

• You cannot delete a channel if there is only one channel.
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3.13 Channel - Copy

Procedure
Carry out the following procedures to copy the waveform data of one channel to another

channel.

1. Click [Copy] from the [Channel] menu.

2. In the dialog box shown below, select the copy source and destination channels

using the list boxes and click the [OK] button.

In the example shown below, the waveform data of [CH3] are copied to [CH1].

3. In the confirmation dialog box, click the [OK] button.

Note
The channel name and unit are not copied.  However, the voltage range is set to that of the copy

destination channel.
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3.14 Channel - Swap

Procedure
Carry out the following procedures to swap the data between two channels.

1. Click [Swap] from the [Channel] menu.

2. In the dialog box shown below, select the two channels in the list boxes and click the

[OK] button.

In the example shown below, [CH1] and [CH3] are swapped.

3. In the confirmation dialog box, click the [OK] button.

Note
The channel name, voltage range, and unit are swapped, not just the waveform data.
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3.15 Channel - Edit

Procedure
Carry out the following procedures to change the channel name, voltage range, and unit.

1. Click [Edit] from the [Channel] menu.

2. In the entry boxes and list boxes in the following dialog box, change the channel

name, voltage range, and unit, and click the [OK] button.
Channel number

Note
• When the voltage range is changed, the waveform data are scaled to the new voltage range.

For example, a value that was “1 V” in the “1 V” range is scaled to “5 V,” if the range is changed

to 5 V.

• If there are multiple blocks, the number of channels and the channel name, voltage range, and

the unit of each channel are set to the same settings for all blocks.

• You cannot assign an identical channel name to another channel.

• Specify the channel name using up to 15 characters.  The following characters can not be used:

["], [\], [/], [,], [.], [:], [;], [<], [>], [?], [*], [ | ], and [space].
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3.16 Block - Insert Above/Insert Below

Procedure
Carry out the following procedures when adding a new block.

1. Click [Insert above] or [Insert below] in the [Block] menu.

To create a block before the target block, select [Insert above].  To create a block

after the target block, select [Insert below].

2. In the dialog box shown below, select the [Target block] from the list box.  Set the

data length of the block to be inserted and click the [OK] button.

In the example shown below, block [2] with a data length of [1,000] is being inserted

after block [1].

3. In the confirmation dialog box, click the [OK] button.

Note
• Up to 256 blocks can be created.

• The data length range is 1 to 4,194,304 points.

• The newly added blocks will contain the same number of channels as the preexisting blocks.
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3.17 Block - Delete

Procedure
Carry out the following procedures to delete a block.

1. Click [Delete] from the [Block] menu.

2. In the dialog box shown below, select the [Target block] from the list box, and click

the [OK] button.

In the example shown below, block [2] is selected as the block to be deleted.

3. In the confirmation dialog box, click the [OK] button.

Note
• If the block being edited is deleted, the block with the smallest number becomes the new block

that is edited.

• You cannot delete a block if there is only one block.
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3.18 Block - Copy

Procedure
Carry out the following procedures to copy the waveform data of one block to another

block.

1. Click [Copy] from the [Block] menu.

2. In the dialog box shown below, select the copy source and destination blocks using

the list boxes and click the [OK] button.

In the example shown below, all the waveform data of block [2] are copied to block

[3].

3. In the confirmation dialog box, click the [OK] button.

Note
An exact copy of the source block is copied to the destination block.  Therefore, even if the data

lengths of the two blocks are different, the data length of the destination block is set to the data

length of the source block.



3-26 IM 707751-61E

3.19 Block - Swap

Procedure
Carry out the following procedures to swap all the waveform data between two blocks.

1. Click [Swap] from the [Block] menu.

2. In the dialog box shown below, select the two blocks in the list boxes and click the

[OK] button.

In the example shown below, block [2] and [3] are swapped.

3. In the confirmation dialog box, click the [OK] button.
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3.20 Block - Change Data Length

Procedure
Carry out the following procedures to change the data length of each block.

1. Click [Change data length] from the [Block] menu.

2. In the following dialog box, change the data length and click the [OK] button.

The selectable data length range is 1 to 4,194,304.

Note
If the specified data length is greater than the original data length, any data beyond the end of the

preexisting waveform are set to 0 V.
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4.1 Exporting to Yokogawa’s Proprietary File Format
(Binary Waveform Data File)

Procedure
1. Click [Export].

2. In the [Save as type] list box within the following dialog box, select [Binary waveform

data file (*.wvf)].

3. Enter the file name and click the [Save] button.

4. In the confirmation dialog box, click the [OK] button.

Note
• When waveform data are saved, a header file “XXXXXX.hdr” is created in addition to the

waveform data file “XXXXXX.wvf.”  The header file is necessary when loading the waveform

data file into the D/A module, for example.  Therefore, make sure not to delete the header files.

For details related to the header file, see section 1.4, “Output Waveform Data.”

• If the waveform data in Yokogawa’s proprietary file format (waveform format file) are loaded into

the 4-CH, 100 ks/S D/A Module WE7281 for the generation of an arbitrary waveform in the FG

mode, the data length is set to “65,536” regardless of the actual data length.  If the data length

of the loaded waveform is longer than this number, then the first “65,536” points are loaded.  If it

is shorter, any waveform data beyond the end of the loaded waveform are set to 0 V.

Chapter 4 Exporting (Saving) Waveform Data
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4.2 Exporting to Waveform Data File (FG Module
File) for the WE7121

Procedure
1. Click [Export].

2. In the [Save as type] list box within the following dialog box, select [FG module file

(*.w16)].

3. Enter the file name and click the [Save] button.

4. In the confirmation dialog box, click the [OK] button.

Note
• Since the file contains only one channel of waveform data, the waveform data of the specified

block and channel are exported.

• The waveform data file is exported according to the following specifications so that it can be

used in the function generator.

Amplitude direction: Data points are assigned values by taking the minimum value of the

edited waveform to be “1” (negative side of Vp-p) and the maximum

value to be 4095 (positive side of Vp-p).

Time axis direction: Exports 16384 points from the beginning of the edited waveform.

Number of data points: If the number of data points is less than 16384, the remaining section is

filled with “2048” (0 V).  If the number of data points exceeds 16384, all

points beyond the 16384th point are discarded.
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Specifications

Files that can be loaded
One file from either of the two formats below

• Waveform data in Yokogawa’s proprietary file format (extension: wvf, header file

(extension: hdr) is also necessary)

The specified channel of the specified block can be edited.

• ASCII data in CSV format

Only the data in the first row can be edited.

Output File Format
Saved to the following two types of files

• Waveform data in Yokogawa’s proprietary file format

Binary waveform data file, extension: wvf, a header file in ASCII format (extension:

hdr) is also created.

Number of bits: 16 bits

Number of channels: In the range 1 to 80

Number of blocks: In the range 1 to 256

Data length: In the range 1 to 4,194,304 (per channel)

• Waveform data for the WE7121

Binary file format dedicated to the WE7121 (extension: w16)

Number of bits: 16 bits (Little Endian.  The lower 12 bits are used.  The upper 4 bits

are ignored.)

Value assignment: Using the maximum and minimum values of the data, scale the

values in the range 1 to 4095.

Data length: 16,384 points (If the number of data points is less than 16,384, the

remaining section is filled with the value 2048.)

Edit Functions
Specify a function

Change the waveform data in the specified area to the waveform created using the

following functions.

Raised Cosine, Half Sine, square wave, triangular wave, rectangular wave, pulse wave,

and ramp wave

Specify a constant value

Change the waveform data in the specified area to a constant value.

Interpolate linearly

Change the waveform data in the specified area to linearly interpolated values between

the first and last values in the specified area.

Delete

Delete the waveform data in the specified area and shift the waveform data succeeding

the area forward.

Copy/Paste

Copy the waveform data in the specified area and paste it to another specified area.

Dot edit

Create a waveform by numerically entering or plotting the passing points and

interpolating the points using a line or a 3rd order spline and paste the waveform to the

specified area.

Waveform dot edit

Change the waveform data by numerically entering or plotting each point (interpolation

using a line or 3rd order spline is also possible).
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Channel Management

Add/delete channels.  Copy waveform data between channels. Swap waveform data

between two channels.  Change the channel condition (channel name, voltage range,

and unit).

Block Management

Add/delete blocks.  Copy waveform data between blocks.  Swap waveform data between

two blocks.  Change the data length.

Waveform Display

• Main screen

Displays all points of the specified block.  Superimpose multiple channels.

• Edit screen

Displays the waveform in the specified area (expanded display)

• Y-axis scale setting

Auto scale or manual scale

Cursor Functions

• Specify the edit area using two cursors.

Specify the cursor position (X value) using the mouse or by entering a value.

• Display the X value (number of points, time) and the Y value (Voltage).

• Cursor link

Fix the distance between the two cursors.

Channel name

Up to 15 characters (checks for duplicate file names).  Symbols that cannot be used: ["],

[\], [/], [,], [.], [:], [;], [<], [>], [?], [*], [ | ], and [space].

Selectable voltage range

Because data are edited as voltage values, select the voltage range from the following.

±1 V, ±2 V, ±5 V, ±10 V

Unit

Up to 10 characters.  Symbols that cannot be used: ["], [\], [/], [,], [.], [:], [;], [<], [>], [?], [*],

[ | ], and [space]

PC System Requirements
Hardware

• PC

PC on which Windows 95/98 or Windows NT 4.0 runs.

CPU: Pentium 133 MHz or higher

• Hard Disk

Minimum free space of 20 MB.  (However, this depends on the data size of the

waveform being edited.)

• Drive

One CD-ROM drive.  This drive is used to install this software.

• Mouse

Mouse supported by Windows95/98 or Windows NT 4.0

• Display

Display supported by Windows 95/98 or Windows NT 4.0.  A minimum of 256 colors

(analog RGB) recommended.

OS

Microsoft Windows 95/98 or Windows NT 4.0

Specifications



Index

Index-1IM 707751-61E

In
d

ex

Index

B

Binary waveform data file .................................................. 4-1
Block .......................................... 3-23, 3-24, 3-25, 3-26, 3-27
Block Management ........................................................... 1-8

C

Change data length .................................................. 1-8, 3-27
Channel ...................................... 3-18, 3-19, 3-20, 3-21, 3-22
Channel Management ....................................................... 1-7
Copy ........................................ 1-6, 1-7, 1-8, 3-12, 3-20, 3-25
CSV format ....................................................................... 1-3

D

Data length ................................................................. 2-1, 2-2
Delete .......................................1-6, 1-7, 1-8, 3-11, 3-19, 3-24
Dot edit ..................................................................... 1-6, 3-14

E

Edit ................................. 1-7, 3-7, 3-9, 3-11, 3-12, 3-14, 3-22
Edit screen auto scale ....................................................... 3-3
Edit values ...................................................................... 3-17
Exiting the Software ............................................................. 8
Export ......................................................................... 4-1, 4-2

F

FG module file ................................................................... 4-2
File ............................................................................. 2-1, 2-3

H

hdr ..................................................................................... 1-9
hdr file ............................................................................... 1-2

I

Insert ............................................................. 3-12, 3-15, 3-17
Insert above ............................................ 1-7, 1-8, 3-18, 3-23
Insert below .......................................... 5, 1-7, 1-8, 3-18, 3-23
Installing the Software .......................................................... 6
Interpolate linearly .................................................... 1-5, 3-10

L

Left edge ........................................................................... 3-4
Linear ..................................................................... 3-14, 3-16
Load data .......................................................................... 1-5

M

Main screen auto scale ..................................................... 3-2
Max ............................................................................ 3-2, 3-3
Min ............................................................................. 3-2, 3-3
Mode ......................................................... 3-5, 3-7, 3-9, 3-15

N

New ................................................................................... 2-1
Num. of blocks .................................................................. 2-1
Num. of channels .............................................................. 2-1
Number of blocks .............................................................. 2-2
Number of channels .......................................................... 2-2

Index

O

Open ................................................................................. 2-3
Overwrite ....................................................... 3-12, 3-15, 3-17

P

Paste ........................................................................ 1-6, 3-12

R

Range ........................................................................ 2-1, 2-2
Right edge ......................................................................... 3-4

S

Sampling rate ............................................................. 2-1, 2-2
Save ........................................................................... 4-1, 4-2
Save as type .............................................................. 4-1, 4-2
Select main screen channels ............................................ 3-1
Set edit screen scale ......................................................... 3-3
Set main screen scale ....................................................... 3-2
Specify constant ......................................................... 1-5, 3-9
Specify function .......................................................... 1-5, 3-7
Spline .............................................................................. 3-15
Starting the Software ........................................................... 8
Sum............................................................... 3-12, 3-15, 3-17
Swap ....................................................... 1-7, 1-8, 3-21, 3-26

T

Target block ............................................................ 3-23, 3-24
Target channel ................................................................ 3-18

V

View ........................................................................... 3-1, 3-2
View graph ........................................................ 3-5, 3-7, 3-16

W

w16 .......................................................................... 1-10, 4-2
Waveform Data for the WE7121 ..................................... 1-10
Waveform dot edit .................................................... 1-6, 3-16
Waveform Edit Function .................................................... 1-5
wvf .............................................................................. 1-9, 4-1
wvf file ............................................................................... 1-2


	Notes on Using This Product 
	PC System Requirements 
	Contents
	Installing the Software 
	Starting and Exiting the Arbitrary Waveform Editor 
	Chapter 1 Explanation of Functions
	1.1 Overview 
	1.2 Files that can be Opened 
	 1.3 Waveform Edit Function/Channel Management/Block Management 
	1.4 Output Waveform Data 

	Chapter 2 New/Open Waveform Data
	2.1 Creating New Waveform Data 
	2.2 Opening Waveform Data 

	Chapter 3 Editing Waveform Data/Managing Channels/Managing Blocks
	3.1 Setting the Waveform Display 
	3.2 Selecting the Waveform Edit Area 
	3.3 Edit - Load Data 
	3.4 Edit - Specify Function 
	3.5 Edit - Specify Constant 
	3.6 Edit - Interpolate Linearly 
	3.7 Edit - Delete 
	3.8 Edit - Copy/Paste 
	3.9 Edit - Dot Edit 
	3.10 Edit - Waveform Dot Edit 
	3.11 Channel - Insert Above/
	3.12 Channel - Delete 
	3.13 Channel - Copy 
	3.14 Channel - Swap 
	3.15 Channel - Edit 
	3.16 Block - Insert Above/
	3.17 Block - Delete 
	3.18 Block - Copy 
	3.19 Block - Swap 
	3.20 Block - Change Data Length 

	Chapter 4 Exporting (Saving) Waveform Data
	4.1 Exporting to Yokogawa’s Proprietary File Format (Binary Waveform Data File) 
	4.2 Exporting to Waveform Data File (FG Module File) for the WE7121 

	Chapter 5 Specifications  
	Index   

